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RTL Design and IP Generation Tutorial

This tutorial provides an overview of the Register Transfer Level (RTL) development and analysis
environment, in which you will:

e Import RTL sources and review them using the Text Editor

e Run Behavioral Simulation on the bft module

¢ Run elaboration to compile the RTL

e Use a variety of RTL analysis features to explore your compiled RTL design. These include:
e Analyze the RTL logic hierarchy using the RTL schematic
e Estimate RTL resources
e Run RTL Design Rules Checks (DRCs)

e Browse the Xilinx® IP Catalog, and customize and implement an Intellectual Property (IP)
core in the design

Many of the PlanAhead™ software analysis features are covered in more detail in other tutorials.
Not every command or command option is covered.

The objective of this tutorial is to familiarize you with the RTL development and analysis process
using the PlanAhead tool.

Software Requirements

The PlanAhead tool is installed with ISE® Design Suite software. Before starting the tutorial, be
sure that the PlanAhead tool is operational, and that the tutorial design data is installed.

For installation instructions and information, see the ISE Design Suite: Installation and Licensing
Guide (UG798) at http://www.xilinx.com/support/documentation/sw manuals/xilinx14 1/iil.pdf.

Hardware Requirements

Xilinx recommends a minimum of 2 GB of RAM when using the PlanAhead tool on larger
devices. For this tutorial, a smaller design is used, and the number of designs open at one time
is limited. Although 1 GB is sufficient, it can impact performance.

RTL Design and IP Generation Tutorial www.xilinx.com 5
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Tutorial Design Description

The small sample design used in this tutorial includes:

e A RISC processor CPU core

e A pseudo FFT

e Four gigabit transceivers (GTs)

e Two USB interfaces

The design targets an xc7k70t device. A small design is used to:

e Allow the tutorial to be run with minimal hardware requirements
e Enable timely completion of the tutorials

e Minimize data size

Locating Tutorial Design Files

Copy the files from the ISE software installation area:

<ISE_install_area>/ISE_DS/PlanAhead/testcases/PlanAhead_Tutorial.zip

Extract the zip file contents into any write-accessible location.

The unzipped PlanAhead_Tutorial data directory is referred to in this tutorial as
<Extract_Dir>.

The tutorial sample design data is modified while performing this tutorial. A new copy of the
original PlanAhead_Tutorial data is required each time you run the tutorial.

RTL Design and IP Generation Tutorial www.xilinx.com 6
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Step 1: Creating a New RTL Project

The PlanAhead tool enables you to create several project types depending on where in the
design flow the tool is being used. RTL sources can be used to create a project for development
and analysis, synthesis, implementation, and bit file creation.

Opening the PlanAhead Tool

Open the PlanAhead tool:

e On Windows, select the Xilinx PlanAhead 14.1 desktop icon or Start > All Programs >
Xilinx Design Tools > ISE Design Suite 14.1 > PlanAhead > PlanAhead.

e On Linux, change the directory to
<Extract_Dir>/PlanAhead_Tutorial/Tutorial_Created_Data, and type
planAhead.

The PlanAhead Getting Started Help page opens.

& XILINX.

Getting Started Documentation

/—T; i Create New Project

Release Notes Guide

Mew Project Wizard will guide you through the process of selecting Information about installation and new IDS features in this release.

design sources and a target device for a new project.

= Open Project User Guide
i

Open any previously created project. More detailed info on PlanAhead commands, dialogs, and buttons.

BERZE

=\ Open Recent Project Methodology Guides
f@ Open one of the most recently used projects. Further assistance adopting PlanAhead flows.
Open Example Project PlanAhead Tutorials
> Open one of the tutorial projects. Invaluable for first time users or to try new features.

Tcl Console —Og =
-

§ ftH
1

Type a Tcl command here

Figure 1: Getting Started Page
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The PlanAhead Getting Started page contains links to open or create projects, and view the
documentation.

Creating a New RTL Project

1. Create a new project called project_rtl, using the RTL source files in:
<Extract_Dir>\PlanAhead_Tutorial\Sources\hdl directory.

2. On the Getting Started page, select the Create New Project link.

3. In the Create a New PlanAhead Project confirmation dialog box, click Next.

The Project Name page of the New Project wizard opens:

[€] New Project {i_hj

Project Name
Enter @ name for your project and specify a directory where the project data files will be stored ({l

Project name: | project_rtl
Project location: | C:\14.1_Tutorials\PlanAhead_Tutorial\Tutorial_Created_Data D
Create Project Subdirectory

Project will be created at: C:\...\PlanAhead_Tutorial\Tutorial_Created_Data\project_rtl

[ < Back ” Next = l Finish Cancel

A T

Figure 2: Entering the New Project Name

4. Browse to, and select
<Extract_Dir>\PlanAhead_Tutorial\Tutorial_Created_Data.

5. Enter the Project name: project_rtl, and click Next.

The Project Type page opens.

RTL Design and IP Generation Tutorial www.xilinx.com 8
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r@ Mew Project . e F& 5% s [ér

Project Type
Specify the type of project to create. g@
@ RTL Project

‘You will be able to add sources, generate IP, run RTL analysis, synthesis, implementation, design planning and analysis.

[7] Do not specify sources at this time

= Post-synthesis Project
‘You will be able to add sources, view device resources, run design analysis, planning and implementation.

Do not spedify sources at this time
Enable Partial Reconfiguration

= Lf0 Planning Project
Do not specify design sources. You will be able to view part/package resources.

= Import ISE Place & Route results
‘You will be able to do post-implementation analysis of your desian.

. Imported Project
Create a PlanAhead project from a Synplify, XST or ISE Project File.

’ < Back “ Mext > | Finish I

Figure 3: New Project: Design Source Dialog Box

6. Select Specify RTL Project, and click Next.
The Add Sources page opens:

€ New Project @

Add Sources
Specify HOL and netlist files, or directories containing HDL and netlist files, to add to your project. e.‘(ﬂ
Create a new source file on disk and add it to your project. You can also add and create sources
Id Mame Library HDL Source for Location
B hdl work Synthesis & Simulation * C:\14.1_Tutorials\PlanAhead_Tutorial\Sources
¥
2 4
| |
Add Files... l | Add Directories... | l Create File... I

[] Scan and Add RTL Include Files into Project
Copy Sources into Project
L Add Sources from Subdirectories

Target Language: Verilog ~

’ < Back ” MNext = ] Finish

Figure 4: New Project: Add Sources Dialog Box
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Adding Directories and Files

7. Click Add Directories , browse to, :
<kExtract _Dir>/PlanAhead Tutorial/Sources/hdl

8. Verify that the following checkboxes are selected:
a. Copy Sources into Project.
b. Add Sources from Subdirectories.

9. Be sure the page is identical to the previous figure (New Project: Add Sources Dialog Box),
and click Next.

The Add Existing IP page opens.
10. Click Next.
The Add Constraints Files page opens:

€ New Project T lﬁ

Add Constraints (optional)

Specify or create UCF constraint files for physical and timing constraints. If there are multiple files then f(ﬂ.
please choose the target, which is where all of the constraints created by PlanAhead will be saved.

Constraint File  Target Location
top.ucf 1@ C:\14.1_Tutorials\PlanAhead_Tutorial\Sources

[ AddFiles... | l Create File...

Copy Constraints into Project

’ < Back ” MNext = ] Finish

Figure 5: Selected Constraint File to Add to the Project

Adding a Constraints File

11. Click Add Files and browse to select the following file:
<Extract_Dir>/PlanAhead_Tutorial/Sources/top.ucf

12. Click OK.
13. Ensure the Copy Constraints into Project option is set to on, and click Next.
The Default Part page opens.

RTL Design and IP Generation Tutorial www.xilinx.com 10
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-
f€ New Project

=)

Default Part
Choose a default Xilinx part or board for your project. This can be changed later.

Specify Filter

Product Category | All - Package | All

&

@ Boards Family | All - | Speed Grade | All -
Sub-Family | All - | Temp Grade  All -
Reset All Filters
[l
Search: | C
) I/O Pin Available LUT ) Block Gb
Device Count I0Bs Elements FETE RAMSs DSPs Transceivers
% xcTvxd15tiffg1927-21 1 927 GEID 257600 515200 880 2160 48
(W% xchvoet8stfigl157-1 303600 [607200
2 XCAVx485tffgl1157-2 1 157 EDD 303600 607200 1030 EBDD
& xc7vx485iffgl157-2L 1,157 600 303600 607200 1030 2800 20
@ xc7vd85tffg1157-3 1,157 600 303600 607200 1030 2300 20 —=
& xc7v485tffg1158-1 1,158 350 303600 607200 1030 2800 48
@ XCA485tffg1158-2 1,158 350 303600 607200 1030 2800 48 o
B e ADCHEA44A D 4 1ca nEn mBANS AN SnTTRAN 4mmn mann Ao
< | ! | r O
[ < Back H Next = ] Finish

Figure 6: New Project: Default Part Dialog Window

Selecting a Default Part

14. In the Filter section, click the Family pull-down menu, and select Kintex-7. The list is

filtered to only show Kintex®-7 devices

15. In the Search field type 70t. The 70t devices are listed.

RTL Design and IP Generation Tutorial www.xilinx.com
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E] e Project @
Default Part
Choose a default Xilinx part or board For vour project, This can be changed later, g@ﬂ
Specify Filker
5 Parks | Produck Category | Al - Package | Al Remaining -
B Boards Eamily | Kintex-7 + | Speed Grade | All Remaining -
Sub-Family | All Remaining = | Temp Grade | &ll Remaining -
Reset all Filkers
Search: 70t {10 matches)
. 1/ Pin Available LuT i Block [la]
ST Count I0Bs Elements FlipFiops RAMs BBl Transceive
i xcTRFObg454-1 454 285 41000 G2000 135 240 4 -
i xcTkTFObg4E4-2 454 285 41000 2000 135 240 4 N
i xR0 bg4E4-2L 454 285 41000 2000 135 240 4
i weTkFORRg484-3 484 285 41000 2000 135 240 4
i Tk FORFEgATE-1 676 300 41000 2000 135 240 g E
fo N TN (T T (R R
i xc7kFOLbge7E-2L G765 300 41000 2000 135 240 g
 xc7kFORbgE7E-3 G76 300 41000 2000 135 240 g | &
i xcTRTOEFbgdE4-2L 454 285 41000 G2000 135 240 4 i
P CCenm o en = Py pamem oo gy = =
< 11 | (=
[ < Back ][ Mext = ] Finish

Figure 7: Selecting a Family and Default Part

16. Select xc7k70tfbg676-2 and click Next.
17. Review the New Project Summary page, and click Finish.

The PlanAhead environment opens.

RTL Design and IP Generation Tutorial www.xilinx.com
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Step 2: Using the Sources View and the Text Editor
The PlanAhead tool allows different file types to be added as design sources, including Verilog,

VHDL, and NGC format cores. The files display by category in the Sources view. Use the supplied
text editor to create or modify RTL sources.

Exploring the Sources View and Project Summary

1. Examine the information in the Project Summary. More information displays as the
design progresses.
2. Examine the Sources view.
Sources - O O =

A IS ey BE

Messages: (Y 16 warnings
—t7 Design Sources (11)
+-5 Verilog (4]
-l round_2 - aR2 (round_2.vhdl) |

i~

+

+W top (top.v) (7)

+\fh round_3 - aR3 (round_3.vhdl) (2}
+-@ bft_th (bft_tb.v) (1)

+-@ round_1 - aR1 (rot

+-@ round_4 - aR4 (rov

‘@ coreTransform -
+H= Constraints (1)

a o o

q5 S
[yt

[=]

T

1)

0

o

Hierarchy | Libraries | Compile Order

£ Sources | 7 Templates

Figure 8: Viewing Sources Hierarchy

The source hierarchy is displayed by default. The tree does not show the top module as
the top level of hierarchy, therefore there is an issue with the compilation of the design.
The design has several VHDL files that have unique Library names. We need to set those
in order for the design to compile and display the correct hierarchy.

Note: VHDL Library names can be set for individual files or for directories when using the Add

Sources dialog box. When creating this project, we selected a single hdl directory which had a
VHDL subdirectory.

Setting VHDL Library Names

3. Click the Libraries tab.

4, Expand the VHDL Unreferenced folder.

5. Use the Ctrl key to select bft_package.vhdl, round_1-4.vhdl, and core_transform.vhd|

6. Right-click to select Set Library

RTL Design and IP Generation Tutorial www.xilinx.com 13
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7. Enter bftLib.

Step 2: Using the Sources View and the Text Editor

Sources

o= e E

O
0y

| EHii# work (85)
: [ Unreferenced (85)
(= VHDL (7)

- work (7)

U EBhft package.vhdl
= Elround_2.vhdl
(=} Unreferenced (5)
b o bft.whdl
2 LB round_4.vhdl
= P round_3.vhdl
2 Plround_1.vhdl
N W core transform.vhdl
[=HE= Constraints (1)

k& constrs_1

[=H& Design Sources (22)
= Verilog (85)

JI. Project Summary x L

=A
=a| % Project Settings
=

Froject Name: proj

[€] Set Library

——

@ Set the library name for selected sources.

Set Library To
Library Mame: bftLib - oz

----- B4 = top.ucf (target)

Hierarchy Compile Order |

% Sources | © Templates |

8. Click OK.

Resource information is

G Implemented Timin
Timing information is not

Next: Run Implementat

Figure 9: Setting VHDL Library Names

Verifying the bftLib VHDL Library

9. Verify that the bftLib folder has the following files shown under it:

Sources

o= watE

[=H& Design Sources (22)
=1 Verilog (85)

| [ work (85)
== VHDL (7)

=+ bftLib (6)

. be@e core_transform.vhdl
il # bft_package.vhd|
@i s round_4.vhdl
i # round_3.vhdl
@i s round_2.vhdl
i ellie round_1.vhdl
=Hii work (1)

Lo s bft.vhdi
[=HE Constraints (1)
= constrs_1

----- Y e top.ucf (target)

RTL Design and IP Generation Tutorial
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Hierarchy Compile Order |

% Sources | © Templates |

Figure 10: Verifying a VHDL Library
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Configuring Simulation Source Files

10. In the Sources view, Libraries tab, expand the Verilog folder and the work subfolder.
11. Scroll to the bottom of the work list and expand the Unreferenced folder.

You should see the bft_tb.v source file. It is a simulation test bench and needs to be set
to Simulation Only.

12. Select the bft_tb.v file and right-click to select Move to Simulation Sources.

13. Click the Collapse All button = in the Sources view header.

The file is now shown under the Simulation-Only Sources folder (it will become a
reference file when it is set as the top file for simulation in a later step).

14. Expand the sim_1 folder under Simulation-Only Sources.

]
®

Sources - 0O

M E g ;
N ey = ] Oq'l'l‘ E

—Hz7 Design Sources (91)
o M= Verilog (84)
- B VHDL (7)
—H= Constraints (1)
. EHE constrs_1
—H= Simulation-Only Sources (1)

—|& sim_1 (1)

—H= Verilog (1)
=i work (1)
—H= Unreferenced (1)
L@ bft_th.y

Hierarchy | Libraries | Compile Order

4h Sources | ' Templates

Figure 11: Viewing the Simulation-Only Sources

Verifying the Design Compilation Hierarchy

15. Click on the Hierarchy tab in the Sources view.
Verify that the design RTL hierarchy is now displayed properly, as shown below.
NOTE: The

RTL Design and IP Generation Tutorial www.xilinx.com 15
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Step 2: Using the Sources View and the Text Editor

Sources
A= et R

Messages: (1) 46 critical warnings

O
g
2

=5 Design Sources (5)
| Verilog (47
i@ top (top.w) (7)

™

[#-%8 mgtEngine - mgtTop {motTop.w) (23)
E—jv} FFtEngine - FFtTap (FFETop, ) (1)
[=h-iehi FfEInst - bft - aBFT (bt vhdl) (£}

i)

8 usbEngined - usbf_top (usbf_top.w) (10)
[-48 usbEnginel - usbf_top {usbf_top.v) (10)
(-1 Constrainks (1)

[ Simulation Sources (1)

&8 clkgen - clock_generator (clock_generator )

i arndl - round_1 - aR1 (roond 1 wvhdl 01
arndZ - round_2 - aR.2 (round_2, vhdl) (5)

arnd4 - round_4 - aR (round_4vhdl) 01
| ingressFifa - FifoBuffer (FiFoBUFFer v (1)
-8 eqgressFifa - FifoBuffer (FiFoBUffer, ) (1)
[+-%8 cpuEngine - or1200_top (oriZ00_kop,w) (200
48 whaArbEngine - whb_conmax_top (wb_conmas_kop,v) (250
-

Hierarchy | Libraries | Compile Order

2 Sources | ' Templates

Figure 12: Viewing the RTL Design File Hierarchy

Defining Global Include Files

16. Click on the Search button a in the Sources view header.

17. Enter timescale in the Search field.

Notice that only files with that text appear.

RTL Design and IP Generation Tutorial
UG675(v14.1) May 8, 2012

Sources

Gl s x
Q== et R
Search: timescale

Messages: ( 46 critical warnings (9 1 warning

(2 matches)

[ZHz> Design Sources (6]
. == Verilog (4)
L@ timescale.v
[=H= Simulation Sources (1)
=& sim_1 (7)
=+ Verilog (4)
L@ timescale.v

Hierarchy | Libraries | Compile Order

£ Sources | 7 Templates

Figure 13: Viewing the RTL Design File Hierarchy
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18. Select the Verilog timescale.v file and right click to select Set Global Include.

Notice that the file is now displayed under the new Global Include folder.

19. Click on the Search button > in the Sources view header to display all files.

Exploring the Sources View Commands

20. Expand and select one of the VHDL or Verilog files in the Sources view.

21. Right-click in the Sources view to review the available popup commands. To dismiss it,
press the Esc key.

Using the Text Editor to View Source File Content

22. In the Sources view, double-click a source file to open it in the Text Editor.
23. Right-click in the Text Editor to view the available popup commands.

24, Close the Text Editor by clicking on the X in the view tab.

Creating a New RTL Source File and Importing a Template

The PlanAhead tool enables you to create new Verilog or VHDL source files. Standard Xilinx
templates can be used as a starting point for a variety of logic and code constructs.

25. In the Flow Navigator under Project Manager, select Add Sources.

26. In the Add Sources dialog box, select Add or Create Design Sources, and click Next.
27. Click Create File... button in the Add or Create Design Sources dialog box.

The Create Source File dialog box opens:

[@ Create Source File tﬁj

.jo:. Create a new source file and add it to your project

File type, name & location
File type: 8 Verilog -
File name: | myfile

File location: | &0 <Local to Project> -

’ 0K l | Cancel

Figure 12: Create Source File Dialog Box

28. In the File name field, type myfile, and click OK.

RTL Design and IP Generation Tutorial www.xilinx.com 17
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29.

30.

31.
32.

33.
34.
35.
36.
37.
38.

In the Add Sources dialog box, click Finish.

The Define Modules dialog appears. This can be used to define a module and its ports.
Click the Cancel button and Yes to confirm. The new empty file is now listed under the
Non-module Files folder list in the Sources view.

In the Sources view, expand the Non-modaule Files folder and double-click myfile.v to
open it in the Text Editor.

Click the Templates view tab (next to the Sources view).

Expand the Verilog subfolders to examine the types of templates available and select
any Kintex-7 template.

The following figure shows the Verilog Templates folder.

Templates — O g =

=M= Veerilog

-- | Device Primitive Instantiation

[ Device Macro Instantiation

[=HE Kintex-7

E_I ' RAM

- -3 Single Port RAM (BRAM_SINGLE_MACRO)

Simple Dual Port RAM (BRAM_SDP_MACRO)

True Dual Port RAM (BRAM_TDP_MACRO)

Dual Clock FIFQ (FIFO_DUALCLOCK_MACRO)

a
[+ DSP48

HH) Spartan-6

H-0 Virtex-5

HHE Virtex-6

H-0 Virtex-7

[+-= Simulation Constructs

[#-= Synthesis Constructs

[+-= Common Constructs

[+ VHDL

[FHE UCF

[ B Y |

Freview
LA 4
. WREN (WREN) 1-bit input =

k=)

2 1: Ll

4 I 2

n o
LI I

&4 Sources. '/ Templates

Figure 13: Examining the Templates in the Templates View

In the Text Editor, right-click and select Insert Template.
The template text is now inserted in the new source file.
Click the X button in the myfile.v view tab.

In the Save Text Editor Changes dialog box, click No.
Select the Sources view tab.

Click the Collapse All button in the Sources view.
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Step 3: Running Behavioral Simulation

Step 3: Running Behavioral Simulation

The Xilinx ISE Simulator (ISim) logic simulation environment is integrated with the PlanAhead
tool. ISim can be used for behavioral or timing simulation. You can run behavioral logic

simulation on the entire design, or an individual module.

Running Behavioral Simulation on the bft Module

1. In the Flow Navigator, select Behavioral Simulation.

2. Click the Simulation Top Module Name browser icon, and select bft_tb, and click OK.

3. Click Launch, and wait for ISim to open.

£ ISim (P 15x) - [Defaultwcfg]

ZE”E Edit  Wiew Simulation  Window Layout

® | o[

+ [0 & X | Objects
Simulation Objects For bft_th

Help

O2Hd

Instances and P..

[E= Hom =)

@ b pE oo [£] G »

i

I P Y Y S
Instance and Process Mam
ﬁ bit_th Object Name Walue
i al |y whDataFaro., 1
% std_logic 1164 & whOutputDa,., 0000000000000000.
¢l std_logic_arith g error )
%9 std_logic_signed [ whClk o
4 bftpackage [ bFtClk o
W vi_types [ reset o
}_, whbDataForln.,., O
I whbiAriteOUt 0
& whinputData.. 1111111111111111
5§ READ_PERIO.. 0000000000000000
5§ WRITE_PERIC... 0000000000000000

] m
.% Instanc

Console

Men ‘{E| «

at 30 ns{1}, Instance [bft_thjuutfarndd ftransformloopl4)/ctf :
at 30 ns1), Instance [bft_tbfuutfarndditransformloop(S) ot/ «
at 30 ns(1), Instance [bft_tbfuutfarnd4fitransformloop(S) et/ «
at 30 ns{1}, Instance [bft_tbjuutfarndd ftransformloopla)/ctf :
at 30 ns1), Instance [bft_tbfuutfarndditransformloop(a)/ct/ «
at 30 ns(1), Instance [bft_tbfuutfarnddfitransformloop(7) et/ «
at 30 ns{1), Instance [bFt_thiuutfarnd4ftransfarmloopl7)\/ct/

“Warning: There is an 'L W'|'2'|-"
Warning: There is an U "W')'Z'-"
Warning: There is an U "W')'2'-"
“Warning: There is an
‘Warning: There is an
Warning: There is an 'U'|%|"W'|'2|
“Warning: There is an 'L [W'|'2'-"

[ 3

Default.wcfg

in an arithmetic operand, the result will be "XY{es). -
in an arithmetic operand, the result will be "¥es),
in an arithmetic operand, the result will be "¥{es).
'in an arithmetic operand, the result will be "%es).
*in an arithmetic operand, the result will be "%'es),
“'in an arithmetic operand, the result will be "%'es).
in an arithmetic aperand, the result will be "¥Yes).

I1Sim>> -
B cConsole j CompilationLog | @ Breakpoints | (9§ Findin Files Results | Egg  Search Results
Sim Tirne: 1L000,000 ps
Figure 14: Launching I1Sim for Behavioral Simulation
4. Close the ISim window. Click Yes to confirm.
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Setting Compilation Order and Disabling Unused Sources

The PlanAhead tool will automatically select a top module, order source files, and display source
files based on compilation order. The top module can also be specified by the user. Files not
needed in the design can be automatically or manually disabled.

5. In the Sources view, Hierarchy tab, expand top and select mgtEngine.

0
s

Sources e
A= R

Messages: @ 4 critical warnings (D 1 warning
[=Hz Design Sources (7)
[+-= Global Include (1)
-- | Verilog (4]
[+ Non-module Files (1)
-|-@& top (top.v) (7)
) clkgen - clock_generator (clock_generator.)

JmgiEngine - mgtTop (mgtTop.v) (23)
| fitEngine - fftTop (fftTop.v) (1)
) cpuEngine - orl200_top (orl200_ftop.v) (20)
) whArbEngine - whb_conmax_top (wh_c
F-#8 usbEngine0 - usbf_top (usbf_top.v )
[+ usbEnginel - usbf_top (ushf_top.v) (10)
[=H= Constraints (1)
H-& constrs_1
=+ Simulation Sources (1)

&0 sim_1 (8)

< | M | »O

Hierarchy | Libraries | Compile Order

x_top.v) (]

£ Sources | 7 Templates

Figure 15: Specifying the Top Module in the Source Hierarchy View

6. Right-click, and select Set as Top

7. Select the Compile Order tab in the Sources view and see that the required source files
and compile order have been updated based on the new top module. To manually
enable or disable a file, select the file, right-click, and select Enable File or Disable File.
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8. Select the Hierarchy tab select top. Right-click, and select Set as Top.

Step 3: Running Behavioral Simulation

Sources =
A= 2egh

*

[=h&7 Design Sources (22)
L@ rocketio_wrapper_tile_gt.v [work]
=+ rocketio_wrapper_tile_gt_usrclk_source.v [work]
» rocketio_wrapper_tile_gt_frame_gen.v [work]
= rocketio_wrapper_tile_gt_frame_check.v [work]
« rocketio_wrapper_tile.w [work]
*
I Unreferenced (86)
[=H= Constraints (1)
k& constrs_1

Ll e top_full.ucf (target)
[=HE Simulation-Only Sources (1)
Ea sim_1 (1)

@ e bft_th.w [work]

Hierarchy | Libraries | Compile Order

£ Sources | 7 Templates

Figure 16: Viewing the Reordered Sources

9. The source file and compile order should be updated.

10. Right-click in the Sources view, select Hierarchy Update. See that three different
options are available, ranging from fully automatic to completely manual file control.

11. Hit the Esc key to cancel the context menu.
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Step 4: Elaborating and Analyzing the RTL Design

The PlanAhead tool provides RTL elaboration capabilities to compile RTL source files in the
project. Displayed compilation errors and warnings are cross-selectable to the lines that are in
error in the RTL code. Once elaborated, the RTL views enable cross-selection of logic objects.
The RTL logic hierarchy is expanded and available for analysis. Opening the RTL Design from the
Flow Navigator automatically elaborates the RTL design and displays the Design Analysis view
layout.

e The RTL Netlist and Hierarchy views display the logic hierarchy of the design.
e The RTL Schematic enables interactive logic exploration.
e The Find command enables searching of RTL logic objects.

e The Instance Properties view displays information about the selected logic instantiation
including resource estimation.

e The RTL DRCs highlight potential areas of the design to improve power or performance.

Elaborating and Opening the RTL Design

1. In the Flow Navigator, select Open Elaborated Design under RTL Analysis.
2. If prompted, click OK in the Warnings dialog.
The RTL Design is elaborated and opened.

3. Click the Messages view tab and click the Collapse All toolbar button

4, Expand to scroll through the Elaborated Design Warnings and Info messages.
Messages —Oag x
A ¥]® 4 warnings  [V|® 7 infos
= =) open_rtl_design -name rtl_1 (3 warnings, 4 infos) i
= -0 [Netlist 42] User property "WIDTH' is incompatible with previously defined property 'width'. Two user defined properties differing just in case are discouraged. [or1200 sprs.:292
@ -0 [Netlist 42] User property "WIDTH' is incompatible with previously defined property 'width'. Two user defined properties differing just in case are discouraged. [usbf pa.vi255
@ -0 [Netlist 42] User property "'WIDTH' is incompatible with previously defined property 'width'. Two user defined properties differing just in case are discouraged. [usbf pa.vi247 L

Netlist 17] Analyzing 22 Unisim elements for replacement
Netlist 28] Unisim Transformation completed in 0 CPU seconds
@) [Project 111] Unisim Transformation Summary:
A total of 20 instances were transformed.
RAMB16_518 => RAMB18EL: 2 instances -
RAMB16_536 => RAMB36EL: 2 instances E‘
DamD1 s DAMDIEE1: A

3 Tcl Console | = Messages | [ Compilation | ) Reports | % Design Runs | 5> Package Pins | O+ [/O Ports

Figure 17: Viewing RTL Design Elaboration Messages

5. Click the checkbox, next to 7 infos on the Messages view header to hide the Infos.
6. Review the Warning messages.

There are no Errors or Critical Warnings in the design. If there were, those categories
would also appear in the Messages view header.

7. Click to enable the Info Messages again, or click the Show All button, in the Messages
view header.
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Step 4: Elaborating and Analyzing the RTL Design

Examining the RTL Logical Netlist and Hierarchy

8. In the RTL Netlist view, expand the usbEngine0 instance by clicking the plus sign (+).

0. Select the usbEngine0/u0 instance.

10.

Right-click and select the Go to Definition popup command.

The RTL file usbg_utmi_iF.v opens in the Text Editor. This is the RTL code that defines
the UTMI Interface module. The file opens to the line containing the usbg_utmi_if

module definition.

Elaborated Design - xc7k70tfbg676-2 (active)
RTL Metlist -0

B Jen
= X

e geen g e
[=H[Z] usbEnginen (1
..

b= i o
sbf_top)

Nets (953)
Primitives (35)

o
3
ol
-
g

T

5
@
3

1

Instance Properties - 0O g =
« +BR
ud

Mame: usbEnginel/uld

Parent: usbEnginel
Cell: usbf_utmi_if
Type: Others

General | Statistics | Instance Pins | Children | Attri 4 » B

& Properties Clock Regions

>
[ Package x | Device x |2 usbf _utmi_ifw x Og x
8| 1Ahead_Tutorial/Tutorial_Created_Data/project_rtl/project_rtl.sres/sources_1/imports/hdl/usbf/usbf_utmi_if.v
130 s
o 5
132 "include "usbf_defines.v"
wdie|133
T 134|r|c::1ule usbf_utmi_if( UTMI Interface (EXTERNAL)
fj 135 phy clk, rst,
13136 DataOut, TxValid, TxReady,
¥ |137 RxValid, Rxictiwve, RxError, Dataln,
JlJ'I 138 XcvSelect, TermSel, SuspendM, LineState,
.- [13% OpMode, usb_vbus,
| 140 =
69_1 141 Internal Interface =
142 rx _data, rx valid, rx_active, rx_err,
& 143 tx_data, tx valid, tx_valid last, tx_ ready,
-';J 144 tx_first,
145
¥|146 Misc Interfaces
3 147 mode_hs, usb_reset, usb_suspend, usb_attached,
4| 148 resume_redq, suspend clr
=129 ):
150
151 input rhy_clk:
152 //input wclk:
153 incut rst: T
€ | 1 »

Figure 18: Viewing the Logical RTL Netlist

11.

In the RTL Netlist view, right-click and select the Go to Instantiation popup command.

The RTL file usbf_top.v opens in the Text Editor. This is the file in which the UTMI
Interface module is instantiated into the design. The file opens to the line containing the

usbg_utmi_if instance.

12.
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The RTL Hierarchy view opens with the selected module. The modules display with
rectangles sized relative to the amount of logic contained in them, making it easy to
locate large modules.

Elaborated Design - xc7k70tfbg676-2 (active) X
RTL Netlist = =l [ Package | @ Device x |8 usbf_utmi_if.v x & RTL Hierarchy Og =

= | E
greTTgTTe e Y

,.
<

m

T
et

=T ] S PR

N O O B 1 0
.

SPRRTON 1 IGIRIRTREGI N M A 1 GV

i
&0 7

Nome:  usbEngnet/0 T I I

Cell:  usbf_utmi_f PR rErrrrr i
Type: Others

General | Statistics | Instance Pins | Children | Attri 4 » B

& Properties Clock Regions

Figure 19: Displaying Modules in the RTL Hierarchy View

13. To close the RTL Hierarchy, click X on the view tab.
14, To close the Text Editor, click X on all open RTL files.

Examining the RTL Schematic
15. In the RTL Netlist view, expand and select the usbEngine0/u0/u0 instance (the level
below the previous selection).

16. In the RTL Netlist view, click the Schematic button or right-click and select the
Schematic popup command.
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i Package x| % Device ¢ | ! RTL Schematic x

-}D 3 Instances

Step 4: Elaborating and Analyzing the RTL Design

ushEnginel
o J ul
L“: J ull
¥
" wltode[1:0]
Wl LineState[1:QlL _ASuspendh
) clkl ATermizel
resume_rag) FovSelect
+ - == ———
[+ st drive_k
= r¥_active] _Amode_hs
i te_readyl Asuspend_clr
J ush vbusl Aush attached
X _lush_reset
% lush_suspend
& usbf_utmi_ls
usbf_utrmi_if
ushf_top

Figure 20: Viewing the RTL Schematic

=]

17. Double-click the LineState[1:0] pin on the outside of the u0 module to expand the logic

outward.

18. If needed, Zoom Fit the RTL Schematic view. The expanded logic is shown in the

following figure.

Hint: Click and drag using the left mouse button in the RTL Schematic view from the lower right

to the upper left to use the Zoom Fit command.

RTL Design and IP Generation Tutorial
UG675(v14.1) May 8, 2012

www.xilinx.com

25


http://www.xilinx.com/

v
i. X"—l NX Step 4: Elaborating and Analyzing the RTL Design

[ Package = | Device x |’# RTL Schematic x oo
+#[]| 4Instances 4 Mets
&
usbEnginel

Qr n
~ un
& B
L3 uo
K LingState r
W L Ophdade[1:0]
- LineState[1:0] LineState[1: _ |Suspendhd
= clk] _|Term3Sel

. resume_reg| _ |#evSelect

RTL wide fdrse 2 rt] _|drive_k

[ rx_active| _|mode_hs
x tx_ready| _|suspend_clr
] ush_vhus| _|ush_attached
& _ush_reset
_lush_suspend
ushf_utmi_ls
usbf_utmi_if
ushf _top
rl

Figure 21: Expanding Logic in the RTL Schematic View

For additional schematic exploration capabilities, see the Design Analysis and

Floorplanning Tutorial: PlanAhead Design Tool (UG676).

19. Select the LineState_r instance on the left side of the RTL Schematic view.

20. In the RTL Schematic view, right-click and select the Go to Instantiation popup

command to display the RTL file with the logic definition.
21. Close the Text Editor and the RTL Schematic.

22. In the RTL Netlist view, click the Collapse All button =

Using the Find Command to Locate RTL Block RAM Logic

23. Click the Find button in the main toolbar jf? or select Edit > Find to open the Find

dialog box.

RTL Design and IP Generation Tutorial www.xilinx.com
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24.
25.

Q,
i

©

fe] Find
Find | Instances -
Criteria
Type - ||is Ml Block Memory -
[ | match Case
Open in a new tab
[ 0K ] [ Cancel
Figure 22: Searching for RTL Logic Using the Find Dialog Box
Examine the Find filter options.
Set the Criteria to Type > is > Block Memory, and click OK.
The Find Results view opens.
Find Results - Instances - Type is 'Block Memory' (21) — O a =
Id Mame Cell Instance Pins
1 cpuEngine/or1200_sb/or1200_sb_fifofasync_fifo/hard_fifo.fifo_gen[68].fifo36_2_inst... FIFO36E1 195 -~
L 2 cpuEngine/or1200_ic_top/or1200_ic_ram/ic_ram0/ramb16_s9_0 RAMB18E1 116
i 3 cpuEngine/or1200_dc_top/or1200_dc_ram/dc_ram/ramb16_s9_0 RAMB18E1 116 -
il 4 cpuEngine/or1200_gmem_top/or1200_gmem_ram/rambl6_s9_0 RAMB18E1 116 B
i 5 cpuEngine/or1200_ic_top/or1200_ic_ram/ic_ram0/ramb16_s9_1 RAMB18E1 116
Ll 6 cpuEngine/or1200_dc_top/or1200_dc_ram/dc_ram/rambl6_s9_1 RAMB18E1 116
i 7 cpuEngine/or1200_gmem_top/or1200_gmem_ram/rambl16_s9_1 RAMB18E1 116
L 8 cpuEngine/or1200_ic_top/or1200_ic_ram/ic_ram0/ramb16_s9_2 RAMB18E1 116
il 9 cpuEngine/or1200_dc_top/or1200_dc_ram/dc_ram/rambl6_s9_2 RAMB18E1 116 -
[il 10 cpuEngine/or1200_gmem_topforl200_gmem_ram/rambl6_s9_2 RAMB18E1 116 D
RAMB18ET 114

26.

27.
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[l 11 cnuFnaine/nr1 200 _ir tan/nr1 200 ic ram/ficr ram0framhif <9 3

Instances - Type is 'Block Memory' (21) x

Figure 23: Find Results for RTL Block RAM Search

The Find Results view displays the results of the find operation.

Select one of the Block RAMs in the list; right-click and select Go to Instantiation.

The instance is selected in the RTL Netlist view and displayed in the Text Editor.

Close the Find Results view and the Text Editor.
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Step 5: Estimating Resource Utilization

Examining the Resource Estimation Options

28. In the Flow Navigator, select the Report Utilization command.

The Resource Estimation view opens.

il Package x | @ Device x |[E Report RTL Utilization

0y
5

A

== Report Utilization
Estimated resources are compared with xc7k70tfbg676-2.
Confidence Level: High
Show More Details
Register
Available: [ 182000
Estimation: [ 18241 (22% of available) top

LuT
Available: [ 141000
Estimation: [} 123910 (58% of available) top
10
Available: [ 1300

Estimation: [ 135 (45% of available) top

Block Arithmetic
Available: [ 1240
Estimation: [T 68 (28% of available) top

Clock Manager
Available: [ 112
Estimation: [FHEE 1 (8% of available) top

Gigabit 10
Available: [ 110
Estimation: [} 18 (80% of available) top

Block Memory
Available: [ 1135
Estimation: [ 1142 (>100% of available) top

MOTE: This netlist has no demand for PCI Express, Global Clock Buffer therefore these resources are not shown

Figure 24: Viewing the RTL Resource Estimation

29. Expand the Block Memory Estimation tree to explore the hierarchical chart report.

Note: The pre-synthesis report shows the Block Memory over utilized in red. Synthesis can often

pack Block Memory in LUTs, so we can ignore this for now.

30. Close the Report RTL Utilization view.
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Examining Resource Estimates for RTL Instances

31. In the RTL Netlist view, select top.
32. In the Netlist Properties view, ensure that the Statistics tab is selected.

The RTL Macro Resources displays in the Netlist Properties view, as shown in the
following figure.

If the Netlist Properties view is not displayed, right-click, and select Netlist Properties.

RTL Metlist — 0O o X
=

R :
(-5 Nets (920)

| Primitives (12)

m

clkgen (clock_generator)
cpuEngine (orl200_top)
fitEngine (fftTop)
mgtEngine (mgtTop)

[-[3] usbEngine0 (usbf_top) -
«| i | r O
&b Sources- 32 RTL Hetlist
Metlist Properties — O a =
+« Bk
2 top
r
RTL Macro Resources
Macro type Flop LUT  BRAM  DSP48 r
Bitwise Logic 0 3510 0 0
Unary Logic 0 272 0 0
Arithmetic 0 4151 0 68
Comparators 0 4877 0 0
Multiplexers 0 10423 0 i
Shifters 0 261 0 a
Storage 18241 416 142 a
Total 18241 23910 142 68
RTL Hierarchy Resources
Child Flop LUT BRAM DSP48
cpuEngine 3861 5363 30 4
fftEngine 2024 1995 16 o4
mgtEngine 2258 1186 24 ]
usbEnginel 4609 6108 36 0
usbEnginel 4609 6109 36 0
wbArbEngine 880 3149 0 0 )
4« [ I " r O

Statistics  Partition

i Properties Clock Regions

Figure 25: Viewing the RTL Resource Estimates

33. Scroll down the Netlist Properties.

RTL Design and IP Generation Tutorial www.xilinx.com 29
UG675(v14.1) May 8, 2012


http://www.xilinx.com/

& XILINX.

34. Examine the properties, including:

RTL Macro Resources
RTL Hierarchy Resources
RTL Primitive Statistics
RTL Memory Resources
Net Boundary Statistics
Clock Report

Step 5: Estimating Resource Utilization

35. In the RTL Netlist view, select other modules and examine the same estimates for the
selected module.
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Step 6: Running RTL Design Rule Checks

PlanAhead provides Design Rule Checks (DRC) that can be run on the RTL Design. These include
LINT-style RTL checks for power or performance improvement suggestions. There are basic I/O
bank and voltage rules for the RTL Design also. After the design is synthesized, a more
comprehensive set of logic design, 1/O, and clock DRCs is available for the Synthesized Design.

Reporting DRCs

1. From the Flow Navigator or the Tools menu, select Report DRC.
2. In the Run DRC dialog box, expand and examine the RTL rules, and click OK.
[@ Run DRC

Results Name: | drc_1

Output File: D
Rules to Check: 47 of 47

My phg EE
< A g

(= All Rules (47)
Bank (18]

=M RTL (10

=+ Performance (6)

. M Inefficient library element instantiation (RFVWL-1)

- Missing pipeline register (RFFR-1)

Inefficient pipeline register (RPIF-1)

Found Black Box instance not belonging to UNISIM library (RFBEX-1)
Found latch in design (RFLD-1)

Found combinatorial loop in design (RPCL-1)

=+ Power (4]

[l Constantly enabled synchronous RAM (RPRC-1)

[l Inefficient dangling BRAM port (RFRM-1)

[l Shallow RAM implemented in Block RAM (RPRS-1)

-l Inefficient mapping of small multiplier in DSP block (RFDS-1)

SelectAll || Clear All |

Open in a new tab

[ DK ] [ Cancel

Figure 28: Running RTL DRCs
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The DRC Results view opens.

DRC - drc_1 (2 violations)

£ 1

- Name Severity Details
=
===k = Al Violations (2)
2| 5® os(@2)
Bl =+ @ Unconstrained Logical Port (UCIO-1)

= - @ UCIo #1 Critical Warning 9 out of 9 logical perts have no user assigned specific location constraint (LOC). Tt
AN [=+@ Unspecified /O Standard (NSTD-1)

“ @ NSTD #1 Critical Warning 9 out of 9 logical ports use IfO Standard (IOSTANDARD) value 'DEFAULT', instead
4 ]

@ drc_1 (2 violations) x

|2 Tel Console | ™ Messages | B4 Compilation | 2 Reports | 1% Design Runs | & Package Pins | Cr /O Ports. & DRC | # Find Resu

Figure 29: Viewing the RTL DRC Results

The DRC Results viewer color-codes messages as follows:
e Errors with a red icon
e Critical Warnings with an orange icon
e Warnings with a yellow icon
e Informational messages with a blue icon
3. Select the UCIO #1 latch warning in the violations list.

The Violation Properties view displays with information about the violation and links to
select the offending logic objects.

4. Close the DRC Results view.

5. Close the RTL Design by clicking the Close X icon in the Elaborated Design banner. Click
OK in the confirmation dialog box if needed.
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Step 7: Selecting IP from the Xilinx IP Catalog

The PlanAhead tool is integrated with the CORE Generator™ tool to provide an IP Catalog with
search and filtering capabilities. This allows you to easily find the desired IP. You can customize,
instantiate and implement the core directly from the PlanAhead tool. You can access the IP
Catalog from the Project Manager and Elaborated Design environments.

Opening the IP Catalog and Exploring the Search Options

1. Select IP Catalog from the Flow Navigator.

2. Expand some of the IP categories.

3. Select any IP and explore the available toolbar buttons and popup menu commands.
L. Project Summary x |iF IP Catalog *= Og
4| search:
=A
=g A1 3
ey | N@mMeE Version AX4 Status License
= [+ Autormotive & Industrial -
48E | [ AXT Infrastructure
& + = BaselP

= Basic Elements

= Communication & Networking

= Debug & Verification

=N=) Digital Signal Processing

) ‘[ Building Blocks

| B Filters

ik CIC Compiler 3.0 AXM-Stream Pre-produ... Included
iF CIC Compiler 2.0 Pre-produ... Included
iF DUC/DDC Comiler Pre-produ... Included

_ Pre-produ...

i

iF FIR Compiler AXI4-Stream Pre-produ... Included
iF FIR Compiler 5 D Pre-produ... Included
[+ = Modulation -
[+ = Transforms B
[+h = Trin Functinn
Details
Name: FIR Compiler i
Version: 6.3
Interfaces: AXI4-Stream
Description: The Xilinx FIR Compiler LogiCORE is @ module for generation of high speed, compact filter implementations that L
can be configured to implement many different filtering functions. The core is fully synchronous, using a single =
clock, and is highly parameterizable, allowing designers to control the filter type, data and coefficient widths, the
number of filter taps, the number of channels, etc. Multi-rate operation is supported. The core is delivered through
the Xilinx CORE Generator System and integrates seamlessly with the Xilinx design flow.
Status: Pre-production i
License: Included i
Vendor: Kilin®, Inc. D
Figure 30: Browsing the IP Catalog
The Details for the selected IP display at the bottom of the view. By default, only the IP
that is current and available for the selected device family is displayed.
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4. To view all IP, toggle the Hide Superseded and Discontinued IPs i button and the Hide
Incompatible IPs button ot .

To view a flattened list of IP, toggle the Group by Category toolbar button }E‘

Type fir in the Search field at the top of the view.

Select a FIR Compiler IP, right-click to select Data Sheet.

Examine the Data Sheet, and then close the PDF viewer.

© o N o wu

Clear the Search field to expand the Catalog list.

RTL Design and IP Generation Tutorial www.xilinx.com 34
UG675(v14.1) May 8, 2012


http://www.xilinx.com/

& XILINX.

Step 8: Customizing and Instantiating IP

Step 8: Customizing and Instantiating IP

Customizing a Simple Adder IP

Click the Group by Category button E7’=E| .
Click the Collapse All button.
Expand the Math Functions > Adders & Subtracters folder.

> W N

Double-click the top Adder Subtracter to run the Customize IP command.

This opens the CORE Generator™ tool and displays the customized interface for the
selected IP. Different IP have different types of interfaces.

[ "J\: Adder Subtracter . - = X ]
Documents View
E = j'_qgiC :‘:P‘! Adder Su btraCter xilinx.com:ip:c_addsub:11.0
Component Name ¢_addsub_v11_0_0
Implement using
A Input Type
B Input Type
A Input Width 15 Range: 2..256
B Input Width 15 Range: 2..256
Add Mode Add -
A1) Output Width 16 Range: 15..16
B[14:01= —>SI180] Latency Configuration Latency 1 Range: 0..258
CLK—>
["] Constant Input Constant Value 000000000000000 (Bin)
cE— Control
Clock Enable (CE)
["] carry In (C_IN) Carry Out (C_OUT) Borrow In/Out Sense |Active Lov
["] Synchronous Clear (SCLR)

["] Synchronous Set (SSET)

1P Symbol | Information|

[] synchronous Init (SINIT) Init Value 0 (Hex)
|| Bypass Bypass Sense Active High
Synchronous Set and Clear(Reset) Priority Reset Over
Synchronous Controls and Clock Enable(CE) Priority Sync Overri
Bypass and Clock Enable(CE) Priority CE Override
Power-on Reset Init Value 0 (Hex)

IGenerateH Cancel H Help ]

Figure 31: Customizing IP With the CORE Generator Software

5. In the B Input Width field, type 18.

6. Click Generate.
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Clicking Generate has a different effect when launched from PlanAhead than when run
from CORE Generator standalone.

¢ In standalone mode, the CORE Generator™ software automatically launches XST
to synthesize the IP core.

e When launched from the PlanAhead tool, the synthesis step is not run
automatically, which lets you instantiate and configure the core in your RTL
before launching synthesis. You can synthesize the IP at any time or launch
synthesis on the entire design for which the IP is synthesized first.

Instantiating the Adder IP

7. In the Sources view, select the IP Sources tab and expand the c_addsub_v11_0_0 IP.

8. Expand the instantiation_template folder and double-click the c_addsub_v11_0_0.veo
file to view the instantiation template in the Text Editor.

Sources —Oag =

¥ Gt ||[E

L 5 o
A & =

=& P (1)
ke c_addsub_v11_0_0 (2)
=+ instantiation_template (1)

5 Non-target Files (1)

Hierarchy | IP Sources | Libraries | Compile Order

5 Sources | ¥ Templates
Generated Data Properties -0 a x
halnd 2L
3 c_addsub_vi1_0_0O.veo
-
Location: c:f14.1_Tutorials/FlanAhead_Tutorig
Type: Verilog Template L
Size: 3.7KB 3
Modified: Today at 15:50:40 PM
Copied To: :/14.1_Tutorials/PlanAhead_Tutarial,
Read-only: Yes
+| Enabled e
4 T » @

L Project Summary x £FIP Catalog x| 2 ¢_addsub_v1l 0_O.veo x

Oa x

8| storials/PlanAhead_Tutorial/Tutorial_Created_Data/project_rtl/project_rtl.srcs/sources_1/ip/c_addsub_v11_0_0/c_addsub_vi1_0_0.veo

354 and outputs ranging from 1 to 258 bits wide. I/0 widths are family

36+ dependent for dspd® implementations.

37
B |38
38 // The following must be inserted into your Verilog file for this
Ej 40 // core to be instantiated. Change the instance name and port connections
18|41 4/ (in parentheses) to your own signal names.

L N e — Begin Cut here for INSTANTIATION Template ---// INST TAG
44c_addsub w1l 0 0 your instance name (
43 .afa), // input [14 : 0] &
@ 46 .b(b), // input [17 : 0] b
47 .clk(elk), // imput clk

bl o

)49 .s(s) [/ output [17 : 0] s

o | 50 13

951 /s msT_TAG_END —--——- End INSTANTIATION Template ---------
|52

4|53 // You must compile the wrapper file c_addsub_v1l_0_0.v when similating
|54/ the core, c_addsub v1l 0 0. When compiling the wrapper file, be sure to
55 // reference the XilinxCorelib Verilog simulation library. For detailed
56 // instructions, please refer to the "CORE Generator Help”.
57

58

* -
%

/

m

Figure 42: Viewing the Instantiated Template

9. Select the text in the Text Editor, as shown above, and click the Copy Text button.

The copied text can easily be pasted into any RTL source file to instantiate the IP. Once
done, the IP can easily be generated through synthesis by selecting the Generate IP

popup command.

10. To close the .veo template file in the Text Editor.

11. Close the IP Catalog.

12. Select File > Exit. If prompted, click No to save and OK to close PlanAhead.
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Conclusion

In this tutorial, you:

e Used a small RTL project to examine the PlanAhead RTL development and analysis
environment.

e Started by creating an RTL project, explored RTL sources and the RTL editor.

e Ran behavioral simulation, elaborated the RTL design, and explored the analysis capabilities,
which included examining the RTL logic hierarchy, RTL schematic exploration, searching for
logic types, reviewing RTL resource and running RTL DRCs.

e Examined the Xilinx IP Catalog, and customized, and instantiated a small adder IP core.
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